Using Siemens NX 11 Software

Surface Design - Mouse

Based on a YouTube NX tutorial®.

thttps://ww.youtube.com/watch?v=k921d540Bw4
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1 — Sketch A.

e Create a model file named mouse.prt and
save it into your local folder.

e In the XY-plane draw a sketch consisting
in a first circle of 100 mm in diameter
centred at the origin, and a second circle of
75 mm in diameter which centre is located
in the x-axis, 75 mm left wise from the

origin.
e Convert these circles as References by =
right-clicking on each one and select Point A

Convert to Reference in the menu.  Specify Point
e Add two points (as references) at the -
intersections of the two circles.

: : +
o Click the Point button  * and select the | e sicetch (1) “SKETCH...
Intersection Point option in the Sketch

Point dialog box.

e Select the first circlem
one.

e Redo the above operations for the second
intersection point.

e Convert these to point to Reference Points
as done here above for the circles.
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e Draw a reference line starting from one
intersection point and finishing at the

other. \
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e Draw a reference circle of 100 mm in

diameter and centred on the middle point™
of the line. \

i/

e Using the Studio Spline button ',
draw approximately a 3-degree spline
curve interpolating four point as shown.

e Add a reference point on the intersection
between the left and centre circles with
positive y-coordinate.

e Constraint the second interpolated point
from the left of the spline to lie on the
above point.

e Add a reference point on the intersection
between the centre and right circles with”]
positive y-coordinate.

e Constraint the third interpolated point
from the left of the spline to lie on the
above point.

e Constraint the left starting spline point
(resp. right ending) to lie on the left (resp.
right) circle.

e Constraint the y-coordinate of the left
starting spline point (resp. right ending)
to be 15 mm (resp. 25 mm).

e Hide all the reference elements (ctrl+b)
and exit the sketch mode. /
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2 — Sketch B: offset, scale and projection. »

e Select the spline curve in the visualization pla— M
window (or in the Part Navigator).
e Inthe Curve tab of the toolbar click on the

S

Offset
Offset Curve button 4%

e In the Offset Curve dialog box, select
Distance as Offset Type and use a distance
of 5 mm. Make sure the offset is oriented "ol s el
as shown.

. : i A
e Click OK to validate. Curves and Points to Scale
] o Select Curve or Point (1) wi ]
e Click on the Scale Curve button :
& Seale Curve
v . Scale A
e Select the above offset curve and choose a
non-uniform scale x=0.9, y=1, z=1. () Uniform {® Mon-Uniform
e Hide the initial offset curve. _ z
\| " Specify CSYS o I_::; .
e Create a new datum plane by clicking the X Scale 0.9 -
D ¥ Scale 1 -
Datum £ 5cale 1 h
Plane = .
Datum Plane button . We will -
project the scaled curve on this plane.
e In the Datum Plane dialog box, select At Cancel
Distance as Type and select the XY plane
as Planar Object. _Datum rlane 0 X
o Set the offset distance 35 mm to the left. = )

13 At Distance -

nar Reference A
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and click OK.

lﬂ%— & Select Curve or Point (1) ‘r m
F'rl:l_i e I':t Objects to Project To A
. . C ' Select Object (1) -+
o Click on the Project Curve button '~ , | =~ ST
and project the scaled curve on the datum | . .. ... - -
plane you just created. A
e Hide the scaled curve. re——
[ Project to Nearest Point along Vector
3 - Mirroring a curve.
e Click on Menu-?Insert>Associative
Copy >Mirror Geometry and select the e
projected curve.
¢ In the Mirror Geometry dialog box,
select as Mirror Plane the XY-plane. K_
4 — Upper surface of the mouse.
e Click on the Through Curves button
IT] Through Curves /
e Select the projected (left) curve an clic
+
on the Add New Set button + :
e Select the middle curve and click the Add
+ .
New Set button again * . i v
e Finally, select the last (mirrored) curve
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5 — Moving the Datum Coordinate System.

e Select the Datum Coordinate System
(either in the visualization window or in
the Part Navigator) and click on the Edit

Parameters button ﬁf
e In the Datum CSYS dialog box, check if
the Type field is set to Dynamic.
e | In the Y field, enter 60 (mm) and press
Enter. \
e[ Then, rotate the reference frame b
180 degrees around the YC axis and click
OK.

¥ Datum CSYS

Type

& Dynamic - | B
Reference CSYS A

Reference Absclute - Displayed | = |
Manipulator A

e Click on the Back view button.
e You should get the sh(I)wn view.

(ep]
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7.a — Surface trimming (sketch).

o Create a new sketch in the XZ-plane of
the moved Datum Coordinate System.
You can notice that the sketch will now
be located above the mouse’s surface.

e Double-click on the orange arrow along
the local z-axis of the sketch reference
frame in order to orient it upwards.

e Draw a 3-point arc of 140 mm in radius
with starting (i.e. left) point coordinate
(18, 20) and ending (i.e. right) point
coordinate (80, 20).

e Create a symmetric arc w.r.t the x-axis.

e Click on the Bridge Curve button

ouf Bridge Curve

e Select as Start Object the upper arc and
as End Object the lower arc.
e Click Apply to validate.

o Select Curve (1) ]‘!Q
®

Revene Boection 3
Endd Object A
(W) Seetiean () Obyeet T Datarn ) Vector r
o Select Curve 1) 51
Reevwti Divection 2
Shape Central A

| on- JREETRIR
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Bridge the other side by selecting as Start
Obiject the lower arc and, as End Object
the upper arc.

Set the Start and End options of the
Shape Control field to 1.5

Note: if you do not manage to select the
arcs individually, check if the Curve Rule
filter is set to Single Curve.

7.b — Surface trimming.

We will now trim the mouse’s surface by
using the above sketch.

e In the Home tab of the toolbar, click on
the Trim Sheet button & Trimshest
=
More
under the More button T of the
Feature field.

e In the Trim Sheet dialog box, select as
Target the mouse’s surface.

e Select as Boundary the above sketch.

e Select as Projection Direction option
Along Vector and select as projection
vector the —YC axis. \

€ Trim Sheet O X

Target A

" Select Sheet Body (1) J

Boundary A

« Select Object (4) 4

[] Allow Target Edges as Tool Objects
Projection Direction A
Projection Direction t Along Vector -

& Specify Vector bl |

[] Project Both Sides

Region

 Select Region (1) ]

®) Keep

“C

() Discard
e

Cancel

£} EBridge Curve O X

Start Object A
(@ Section () Object
 Select Curve (1) f“a
Reverse Direction l,\’.
End Object A
i® Section () Object () Datum () Vector
« Select Curve (3) s
Reverse Direction l,\’.
Shape Control A
Method Tangent Magnitude -
Start 1.5 -
End 1.5 -
w
Cancel
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8 — Surface extrusion.

.

e Click on the Extrude button = ~ and
extrude the above trimmed surface
contour by 25 mm along the —YC axis.

e In the Settings field, set the Body Type
option to Sheet.

EE T

Section A

W Select Curve (4) B m

Direction A

 Specify Vector \EDFL"TJ

Limits A

Start i) Value -

End P Value -

[] Open Profile Smart Volume

Boolean A
Boolean {None) Wj
Draft v
Offset v
Settings A
Body Type [sheet -]

Tolerance

Preview

7
T peey || concel |

9-—

Drafting a surface.

Hide temporarily the (upper) mouse’s

surface and click on the Draft button
& Draft

In the Draft dialog box, select Edge as
Type and the —YC direction.

Select the upper edges of the last
extrusion and use an angle of 15 degrees.
Make visible the mouse’s surface.

[
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10 — Trimming the (drafted) extrusion.

Create a datum plane parallel to the ZX-
plane and located 38 mm below it.

Click on the Trim Body button
(F# Trim Body

Select the (drafted) extrusion as Target.
In the Tool field, select the above datum
plane.

Note: if needed, click on the Reverse

a

Direction button A in order to keep
the right part of the extrusion.

£} Trim Body

s A

—

11 — Edge blending.

Before blending edges, it is a good
practice to Sew (i.e. connect) their
corresponding surfaces.

Click on
Menu 2Insert 2Combine 2Sew...

Select as Target the (upper) mouse’s
surface and as Tool the (drafted and

trimmed) extrusion.
s

Edge

Click on the Edge Blend button °"

and select the edge connecting the
mouse’s surface with the extrusion.
Enter a blend radius of 3 mm.

Target A

¥ Select Body (1)

Tool A
Tool Option Face or Plane A
4" Select Face ar Plane (1) Elj
Reverse Direction ‘\{

Cancel

{3} Edge Blend
Edge A
Continuity T3 G1 (Tangent) -
« Select Edge (4) [ffj
Shape "y Circular -
Radius 1 3 mm -
Add New Set o
-
< 0K = Apply Cancel
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12.a — Mouse buttons (sketch).

e Create a new sketch in the ZX-plane of
the Datum Coordinate System. Do not
forget to set the z-axis of the sketch’s
coordinate system to point upwards.

e Draw an ellipse (Ellipse button ) of

major radius 16 mm, minor radius 7 mm
and rotation angle of 0 degrees.

e Constraint the ellipse’s centre to be
located along the y-axis and lie 10 mm
from the x-axis.

e Construct a symmetric ellipse w.r.t. the
x-axis and exit sketch mode.

12.b — Mouse buttons.

The (upper) mouse’s surface will be
deformed within the regions defined by the
two above ellipses for figuring the mouse
buttons.

e Click on Menu -2Edit *Surface >Global
Shaping.

¢ In the Global Shaping dialog box, select
the (upper) mouse’s surface as Sheet to
Deform.

e Select as Region to Deform a first ellipse.

e Inthe Target Point field, selecta 1 mm

Offset and use the —YC axis as Projection

Direction.
e Click Apply and redo the above
operations for the second ellipse.

—

£} Ellipse O X
Center M
 Specify Point F A
Major Radius A
" Specify Point __l_ -
Major Radius 16 mm v|
Minor Radius M
" Specify Point __l_ o
Minor Radius 7 mm v|
Limits A
Closed
Rotation A
Angle | 0 deg v|

Jeyma), dysads A
3] worzaiig

B HIN PR
B0
wag Guads A

uioy yabiey
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+ "L Assembly Constraints

13 — Closing the mouse bottom. &

o' Move Component

Surface A‘id * Pattern Component
e Click on the Bounded Plane button.  ~_ —_— eoupncame | . ) —Em-e-
e Select the bottom curves of the mouse in o ;:‘SWE“ " R
- u &5 Fill Surface -
order to close its bottom. N '

Surface

Recently Used -

[=l Bounded Plane ] Ruled

e Sew (Menu-2?Insert *Combine >Sew)
this new plane with the remaining of the =
mouse. 2 Boundeapiane 7 Ruied

e Add an edge blend of 1 mm between this
plane and the remaining of the mouse.

e Finally, hide all the sketches.

| Bounded Plane D X

i | Planar Section A

{= Variational Sweep

| & Select Curve ()

Apply Cancel o 4
b A L4

[ Mirrar Geometry (6)

- @ Through Curves (7)

A G Sketch (8) "SKETCH_D...
A S Bridge Curve (9)

715 Bridge Curve (10)

- [ LF Trim Sheet (1)

[ Extrude (12)

- @ @ Draft (13)

4[] Datum Plane (14)

[ 5 Trim Body (15)

A Sew (16)

- [ 3 Edge Blend (17)

ARG Sketch (18) "SKETCH_...
A% Global Shaping (19)

- 12 Global Shaping (20)

U NE T N0 UL U U0 U0 TR U0 U UL SR UL UL U Y

O Sew O X

Type A
Sheet

Target A

« Select Sheet Bady (1) &

Tool A

W Select Sheet Body (1) ()

-

Cancel

P

B

G4 S G5 4

lyTr\m Sheet (11)

[ Extrude (12)

& Draft (13)

{3 Trim Body (13)
[E] Sew (18)

gEdge Blend (17)
B skt Tc
7 Global Shaping (19)
+2 Global Shaping (20)
[Z Bounded Plane (21)
s ToF
& Edge Blend 24

SR N T T T TR TR T T TR T T R TR T N T
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14 — Designing the mouse’s wheel.

In the XY-plane, draw a circle centred at
coordinates (5, -38) and of 42 mm in
diameter.

Extrude the circle by 2 mm from either
side of the curve in order to obtain a
cylinder (check if the Body Type option
is set to Solid and the Boolean option to

None).
s

Edge
Apply an edge blend BT 5f 1.5 mm

on both edges of the cylinder.
Trim the cylinder by the bottom of the

mouse using the Trim Body button
(fiE Trim Body

Finally, unite & Y the trimmed
cylinder with the mouse.

A~

15 — Hole around mouse’s wheel.

In the Curve tab of the toolbar, click on
the Offset Curve in Face button
<gs Offset Curve in Face

In the Offset Curve in Face dialog box,
set the Type option to Constant and select
the intersection curve between the
mouse’s wheel and its upper face. Set the
Offset option to 0.5 mm.

A&M - CAD in mechanical engineering
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e Divide the upper face of the mouse into

e Click on the Pull Face button

¢ Inthe Pull Face dialog box, select the

two parts using the offset curve as
boundary. For this, click on the
“Menu Insert 2Trim ->Divide face
button == Divide Face...

G Pull Face |40ated under the Home tab
of the toolbar, under the More button of
synchronous Modelling.

small face surrounding the mouse’s
wheel.

e Specify the —YC vector and a Distance of

Distance

0.5 mm.
[} Pull Face ) X
Face A
" Select Face (1) FF
Transform A
Mation t«z> Distance v
" Specify Vector _IE @
Distance | 0.3 mm v|
=
-
Apply
r;E,Hirrchecmetr_ ¥ L'd
@7 Through Curves (7) v
B Sketch (8) "SKETCH_D... «*
E‘:_:EE-":::_;E Curve (9 [
Sul Bridge Curve (10 Y
LF Trim Sheet (11) g
Edge
Elend =

e Apply an edge blend

e Finally, hide any visible sketch.

of 0.25 mm

\

on the shown edge.
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16 — Materials and visualization.

Select the Assign Material button

% Assign Materials... located in

Menu ->Tools *Materials and select
Polycarbonate as material.

In the Render tab of the toolbar, click on

>

True

the True Shading button Shading

Select all the mouse surfaces but the
external (visible) faces of the wheel.
Click on the Object Materials button

9

Object
Materials -

and select the Blue Glossy
Plastic button.

Eventually, hide the Datum Coordinate
System.

You should obtain an object as shown at
the beginning of this tutorial.

0 D PJ Show Shadows [
G .
= Show Floor Reflection

Object Graduated Light : N
Materials * Grey Background = ) Show Floor Grid -
Set
Recently Used a [N eu?
<« @ W S AN

Object Materials

0000 e
P e Y Ly
Blue Glossy Plastic

Assigns a blue glossy plastic to selected bodies and
faces.

W %l W
©0006@ =0
©0 0V a.
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